
0 
 

 

 

 

Chromatogram Analysis 

User’s Manual 
 

 

 

 

October 2025 

5.11 

 

 

 

 

 

 

 

 

Protein Metrics LLC, Boston, Massachusetts, USA 
 

  



 Chromatogram Analysis Manual v5.11                                                                
 

  

  

Contents 

Introduction .................................................................................................................................................................2 

Windows Support ........................................................................................................................................................2 

System Specifications.................................................................................................................................................2 

Workflows ...................................................................................................................................................................3 

Tour of Chromatogram Analysis .................................................................................................................................4 

Project Creation ..........................................................................................................................................................5 

Samples tab (Reference Chromatography) ............................................................................................................5 

Trace Peaks Options ...........................................................................................................................................7 

Samples tab (Comparison Chromatography) ...................................................................................................... 11 

Sequences tab ..................................................................................................................................................... 13 

Processing nodes ................................................................................................................................................. 14 

Main Menu Bar ........................................................................................................................................................ 30 

File Menu ............................................................................................................................................................. 30 

File > Export Menu ............................................................................................................................................... 30 

Edit Menu ............................................................................................................................................................. 32 

Window Menu ...................................................................................................................................................... 37 

Help Menu ............................................................................................................................................................ 38 

Table Menu Bars ..................................................................................................................................................... 38 

Filter Options ........................................................................................................................................................ 39 

Table Right-Click Menus ...................................................................................................................................... 41 

Project Table and Menu ....................................................................................................................................... 42 

Peaks Table and Menu ........................................................................................................................................ 43 

Candidates Table and Menu ................................................................................................................................ 44 

Protein Coverage Table Display and Menus ....................................................................................................... 46 

Plot Menu Bars ........................................................................................................................................................ 47 

Plot Right-Click Menus ......................................................................................................................................... 49 

Trace Plot and Menus .......................................................................................................................................... 51 

MS1 Plot and Menus ............................................................................................................................................ 53 

Appendix .................................................................................................................................................................. 54 

Chromatogram Analysis: Advanced Commands ................................................................................................. 54 

 

 

 

 

 



 Chromatogram Analysis Manual v5.11                                                                
 

  

  

Introduction 

Byos hosts a number of workflows incorporating Chromatogram analysis that can be used for detailed, 
chromatogram-centric analysis of peptide and glycan samples. It is used from late discovery through clinical 
development to define design space and product profile and it supports Multi-Attribute Method (MAM) reporting. A 
map serves as a signature of a digested purified protein or released glycans or any other separable chemical 
mixture.  

Chromatogram Analysis enables researchers to quantitatively characterize their product down to low concentration 
components and reduces analysis time while increasing confidence. Flexible summary tables can quickly generate 
reports for non-mass spec stakeholders for internal review, or for application filings. For peptide or glycan mapping 
needs, Byos provides efficient and comprehensive interactive workflows.  

Chromatogram Analysis in Byos has two modes of operation: annotation and comparison. Annotation (reference 
projects) assigns or “maps” identifications to the trace peaks in a liquid chromatogram (LC) or capillary 
electropherogram (CE). The reference (peptide or glycan) map comes from an annotation project. Comparison 
(comparison projects) aligns and quantitatively matches related chromatograms or electropherograms relative to a 
reference map. 

Chromatogram Analysis can also be deployed in a fully automated workflow to allow for large numbers of samples 
to be analyzed and reported on in a consistent fashion. 

Features include: 

● Support for multiple optical data channels such as UV absorption or fluorescence and TIC (total ion 

chromatogram) for LC or CE 

● Automatic baseline correction and trace peak area integration 

● Peptide and glycan identifications are made automatically by accurate mass (MS1) matching 

● Identifications are made from candidates imported from MS/MS identifications, in-silico *.csv format table, 

in-silico protein digestion during project creation, and/or manual entry 

● Annotations may be inspected in detail and evaluated by the analyst 

● Simultaneous comparison of many LCs or CEs with optional trace time alignment by dynamic time 

warping 

Windows Support 

Byos Desktop is currently supported on Windows 10 and Windows 11. Note that for Windows 10, you must have 
version 1809 or later.  

System Specifications 

• Recommended PC: 
o Windows 10/11 64-bit  
o 32 GB RAM 
o 1TB disk space (Solid State SSD) 
o Recent version of Intel Core i7 or i9 / AMD Ryzen 7 or 9 (with AVX support) 
o Oracle JRE or OpenJDK 
o C++ compiler version 16 or higher 

• Recommend PC for high performance computing (e.g. 32+ cores) 
o Windows Server 2022 or Windows 10/11 
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o 64 GB RAM 
o 2 TB disk space (Solid State SSD) 
o Xeon CPU(s) (at least 16 physical cores) (with AVX support) 
o Oracle JRE or OpenJDK 
o C++ compiler version 16 or higher 

Note that standalone applications are no longer supported outside of Byos and that Chromatogram Analysis is 
performed using Byos workflows. 

Raw mass spec data are accepted from these vendors: Thermo Fisher, Waters, Sciex, Bruker, or Agilent. Optical 
data may be embedded in these files or imported via a *.csv file of time-intensity data pairs 

Workflows 

 

Figure 1: Peptide and Glycan Annotation (Reference) Workflow 

 

 

Figure 2: Peptide and Glycan Annotation (Comparison) Workflow 
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Tour of Chromatogram Analysis 

The Chromatogram Analysis user interface (UI), or dashboard, shown in Figure 3 has six plot and table views: 

 

Figure 3: Six Chromatogram Analysis views: (1) Project table with input MS files, (2) Trace plot with selected 
peak, (3) Peaks table, (4) Candidates table (elution peaks), (5) Protein Coverage tables, and (6) MS1 spectrum 
(summed spectra). 

1. The Project view lists the data files in use. R project is a reference project, M project is a multi-sample 
project and C project is a comparison project.  The Show trace and Show peaks check boxes can be used to turn 
on or off the trace plot and the trace peak lists displayed in Views 2 and 3.  

2. The Trace plot shows the total ion chromatogram (TIC), base peak intensity (BPI), and/or UV traces for 
the peptide or glycan. In many ways, this is the heart of the interactive software. The adjustable magenta-colored 
integration limits in the trace plot view highlight the trace peaks under study. The mass spectrum (MS1) displayed 
in View 6 is determined by the trace time designated by a black bar on this plot. This bar initially is set by 
Chromatogram Analysis to be at the peak apex. 

3. The Peaks table summarizes the peptide or glycan peak information from the trace plot. Selecting a row in 
the table selects a peak in View 2. Trace peaks can be merged, split, added, or deleted using the buttons at the 
top. Time limits can be adjusted by editing text in View 3 or dragging the magenta bars shown in View 2. 

4. The Candidates table is where trace peak candidates are identified and assigned. 

5. The Protein Coverage tables are where peptide sequences are identified and assigned to a peptide map 
peak. An assigned sequence appears in the Protein Coverage map. The sequence under current investigation is 
highlighted by the green bar becoming orange. The user can also click on any other green bar to highlight that 
sequence and change the other panes accordingly. A table, which may be hidden, reports the fraction of the 
protein(s) sequence covered by identification.  

6. MS1 shows the summed m/z plot for the trace peak selected in Views 2 and 3. By default The a single MS1 
spectrum is shown, associated with the trace time designated by the black bar in the trace plot view. The trace time 
of the MS1 spectra can be changed by moving the vertical black bar to a different time. Doing so can help increase 
understanding of the elution of peptides within the peptide peak. When the EnableMS1Sum = true advanced 
command is included, the displayed MS1 will be the sum of all scans between the two pink bars that mark the 
selected trace peak boundaries.  
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Note that four of these views (Project, Trace plot, Protein coverage, and MS1) may be detached by a double-click 
on the top of the view. The views can also be resized and rearranged. For example, the MS1 or Trace plot view can 
be detached and moved to a second large monitor for easier viewing. These panes may be reinserted, in any 
available position to rearrange the layout. Layouts may be saved for later use with the Window > Save Layout 
menu.  

Project Creation  

Chromatogram Analysis can be used to analyze a single sample or to compare several related samples. 
Comparison of related samples starts with the analysis of a sample chosen to be the reference sample. To create 
a reference project, select the Reference Chromatography system workflow.  

  

Figure 4: New Reference Project 

Samples tab (Reference Chromatography) 

The Samples tab allows the user to load reference sample files into the project. Chromatogram Analysis accepts 
a variety of sample file types (Bruker: .d, Thermo: .raw, Waters: .raw, Sciex: .wiff, Agilent: .d). Alternatively, a 

project can be opened from a *.byrslt file generated from a previous ByonicTM search, or a Peptide Analysis 

(ByologicTM) *.blgc project file. To load a file, drag and drop an MS file into the project window. Alternatively, 

double-click on Enter filename, click  and browse to the file. Click Open. 
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Figure 5: Adding samples and their traces in the Samples tab 

The sample is named for the file name; to change the sample name, click the default name twice and enter a new 
sample name. Click Add sample at the left to add a new row to the Samples table. Then add the desired files as 
above. To remove an unwanted sample file row, select the row and click Remove sample(s). 

Adding the MS file populates both the Samples table and the new Traces table at the bottom. Selected (not 
checked) traces can be removed by clicking Remove trace(s). Removed traces can be restored by clicking Add 
missing traces, check the trace to restore and click OK. To associate specific traces to the samples, double-click 

the text in the Selected samples column, then click the  button to open the Edit samples selection dialog: 

  

Figure 6: Edit samples selection dialog to associate traces with sample names 
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To associate the selected trace with an individual sample, uncheck All samples, check a single sample, and click 
OK. Note that multiple checked samples are not supported for traces. 

To import a trace from a *.csv file, drag the file into the Traces files column in the Samples table. Alternatively, 

double-click in the Samples table row under the Traces file column, click  and browse to the sample file. Click 
Open. The trace file is added to the sample name and the trace is added to the Traces table: 

  

Figure 7: Traces imported from a *.csv file 

Multiple traces can be added to a sample. To add additional trace files, click in the Traces file cell, click the  icon 
and navigate to the new trace file, as before: 

 

Figure 8: Adding multiple trace files to a sample 

To remove a trace file, click in the Traces file cell to be removed and click the  icon. 

Byonic MS/MS search files in *.byrslt format can be dragged or navigated into the MS/MS search column. 

Trace Peaks Options 

To control how the trace peaks are processed, click Edit peak options presets at the bottom:  
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Figure 9: Trace peak options presets 

At the bottom of the Trace peak options presets dialog are the Baseline parameters. The baseline type can be set 
to Auto or Flat. Baseline smoothing width is also set here. 

The Trace peak options presets dialog contains five default peak processing presets: 

 

Figure 10: Default trace peak presets 

Select a processing preset and edit the peak parameters. To create a custom preset, click the  button, add a 
preset name, and click OK. Next, select a creation type and edit those peak parameters. The new preset is added 

to the list. Click the  button to edit a selected preset name. Click the  button to delete a selected preset. 

The default and custom peak processing presets can use one of four Creation types: 

 

Figure 11: Trace peak Creation types 

These Creation types use the following peak processing methods: 

● Single Slice processes the entire trace as single peak. 

● Custom slice(s) divides trace peaks by user defined start and end points: 
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Figure 12: Trace peak Custom slice option 

Click Add row and enter start and end points for each slice. To remove a slice, select it and click Delete 
row. 

● Fixed width slice(s) divides trace peaks by regular intervals defined by the user: 

 

Figure 13: Trace peak Fixed width slice(s) option 

● First slice range sets the start and end points for the first slice. This also sets the width for all slices. 

● Step is the delta that sets the start of subsequent fixed width slices by adding the step value to the start of 
the preceding slices. For example, the values above define the first slice as 0 - 5, the second slice as 2.5 – 
5, etc., through the end of the trace.  

● Number of slices sets the maximum number of defined slices. If blank, the last slice is determined by the 
end of the trace x-axis range. 

● Show Example displays an example fixed width slice configuration with definitions and explanations: 
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Figure 14: Fixed width slice Usage example 

● Compute peaks automatically determines the trace peaks based on their minimum width, after 
smoothing: 

 

Figure 15: Trace peak Compute peaks option 

Choose peaks, when checked, limits the detected peaks to the specified x-axis range. The option that contain 
apex within selects the whole peak of each apex within the specified range. The option truncated by trims the first 
and last peak to fit within the specified range. 

Global trace peak filters can also be applied. To set peak property filters for all the traces, click Edit Global trace 
peak filters: 
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Figure 16: Global trace peak filters 

Check Show peaks within range to manually set start and end points. Minimum peak area sets a Normed area 
% cutoff filter. Normed area % is calculated by dividing the peak area of an individual trace peak by the sum of all 
trace peak areas within the Global filter retention time range, set with Show peaks within range. In the example 
above, any trace peak with a Normed area % less than 0.1% is filtered out. Flag if peak ratio above or below: sets 
a peak ratio (relative to the reference sample) threshold flag and is only applicable for comparison mode projects. 

The Traces table and trace peak settings are backwards-compatible. Traces associated with samples in projects 
from software versions before 3.8 will correctly populate the Traces table in the current version. Trace peak settings 
and presets from versions before 3.8 will correctly migrate into the current version. However, Intact Analysis and 
Chromatogram Analysis projects created in versions 3.8 and above will not correctly open in older versions of these 
applications. 

Samples tab (Comparison Chromatography) 

Byos supports comparison of multiple traces on the same protein or released glycan molecules for lot-to-lot 
comparability, biosimilarity, and degradation studies. Byos also supports multi-sample projects for high-throughput 
analysis of many targets. 

To create a comparison project in Byos, select the Comparison Chromatography system workflow. Project 
Creations for Comparison Chromatography workflows share the same general settings as the Reference 
Chromatography workflows. However, in the Samples tab of Comparison Chromatography workflows, Enable 
Comparison mode is checked on and an additional Sample type column exists in the Samples table. The Sample 
Type column allows the user to designate Samples as Reference or NonReference for Comparison Mode analysis. 
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Figure 17: Sample Type column in Comparison Chromatography 

The Enable Comparison mode option is checked by default for Comparison Chromatography workflows.  

 

 

 

Figure 18: Comparison Chromatography workflow 
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Sequences tab 

The Sequences tab allows the user to enter a protein sequence either by adding a FASTA file or by typing it in 
directly.  

 

Figure 19: Sequences tab in Chromatography projects 
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Processing nodes 

 

 

Figure 20: Processing nodes parameters – Reference Chromatography 

MS/MS Ids 

NOTE: These parameters are not part of the Reference Chromatography (in-silico) or Characterization 
Chromatography (in-silico) workflows 

• General 

 

Figure 21: General 

o Samples - The “*” will apply all parameters to all samples dragged and dropped into the Samples 
tab. 

o Results Folder Name - This is automatically set to “Byonic” and will be applied to the additional 
processing (as defined in the workflow). 

• Protein database optionz 
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Figure 22: Protein database options 

The protein database options Add Common Contaminants (default setting = No) and Add Decoys 
(default setting = Yes) were added to the Byonic Processing node in v. 3.9. The protein database should 
contain both targets and decoys (recognized by protein names beginning >Reverse or >Decoy) for false 
discovery rate (FDR) estimation. Byonic will automatically add decoys if the Add decoys box is checked 
and contaminant proteins (e.g., trypsin, bovine serum albumin, and human keratins) if the Add common 
contaminants box is checked. The common.contaminants.fasta database is located here: C:\Program 
Files\ProteinMetrics\PMI-Suite\Tools\Byonic\data 

• Instrument Parameters 

 

Figure 23: Instrument Parameters. Optimize for the experiment completed. 

In the figure above, the user set 6.0 ppm Precursor Mass Tolerance, 0.60 Da Fragment Mass 
Tolerance, and QTOF/HCD as the Fragmentation Type. Both Dalton and ppm mass tolerances for 
precursors and fragments are supported, along with several fragmentation types. The Dalton tolerance 
applies to measured mass for precursors but measured m/z for fragments. The way scoring is completed 
changes at fragment tolerances of 0.1 Da or 100 ppm or less: high-resolution MS/MS is assumed, 
meaning resolution sufficient to distinguish charge states of fragment ions. For this reason, fragment 
tolerances larger than 0.1 Da should be used with low-resolution (ion trap) MS/MS analysis. 

Internal models for most fragmentation types are included – CID low energy (ion trap), QTOF / HCD 
(beam-type CID), and ETD / ECD (electron transfer and electron capture dissociation), as well as a 
number of combinations of types. These internal models determine which fragment peak types will be 
scored and annotated. For example, prominent c- and z-ions and small y-ions are expected for ETD. 
Prominent oxonium ions are expected from glycopeptides with QTOF / HCD fragmentation, but small or 
missing oxonium ions from CID low energy. 

o Precursor Mass Tolerance  

 

Figure 24: Precursor Mass Tolerance 

The user can change this value by clicking within the text box and then clicking on the activated 
blue “…” square. The user can then modify the text value and mass accuracy, as required. This is 
shown in the figure below. 
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Figure 25: Modify the text value and mass accuracy 

o Fragmentation Type 

 

Figure 26: Fragmentation type. 

The user can select from the available options using the drop-down menu. Additional options are 
visible using the scroll bar, including “Both:” for spectrum file(s) containing more than one 
fragmentation type. 

o Fragment Mass Tolerance 1 - The user can set the value used to acquire data in either ppm or 
Da. 

o Fragment Mass Tolerance 2 - If necessary, the user can set the value used to acquire data in 
either ppm or Da. This is only required for the “Both:” Fragmentation Types. No value will be 
applied if only a value for “Fragmentation Mass Tolerance 1” was entered. 

o Recalibration (lock mass) 

 

Figure 27: Lock mass calibration options 

The user can select from the available options using the drop-down menu. 

• Digestion 
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Figure 28: Digestion options 

The Digestion settings allow the user to set the residues recognized by the digestion enzyme. In this 
example, the enzyme is trypsin, so the user entered RK for arginine and lysine for the Cleavage Site(s) 
and chose C-terminal for the Cleavage Side.  

o Cleavage Site(s) - The user can change this value by entering text. If the user leaves the 
Cleavage Site(s) box empty, the only specific cleavage sites are protein termini. 

o Cleavage Side  

 

Figure 29: Cleavage Side options 

The user can change this by selecting another option from a drop-down menu. Click on the 
current selection to activate the available options.  

• Digestion Specificity  

 

Figure 30: Digestion Specificity 

Here the user chose “Fully specific (fastest)” search, meaning that both the N- and C-terminal cleavages 
must be C-terminal to R or K. Nonspecific cleavage at either or both endpoints is supported. A 
nonspecific search with RK in the Cleavage Site(s) box searches all peptides but favors tryptic peptides; 
the user must leave the Cleavage Site(s) box empty for a true no-enzyme search. Digestion Specificity 
can be changed by selecting another option from a drop-down menu. The user can click on the current 
selection to activate the drop-down menu to view the available options.  

o Missed Cleavages - The user selected 2 Missed Cleavages, as shown in Figure 28. This limits 
the maximum number of internal Rs and Ks not followed by P to 2; leaving Missed Cleavages at its 
default value of -1, which means any number of internal Rs and Ks. Missed Cleavages can be 
changed by entering text. 

 

• Modifications 
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Figure 31: Modifications options 

Like most proteomics search engines, two types of modifications are supported: fixed and variable. A 
fixed modification is assumed to occur on all the residues of that type, but a variable modification is 
optional, so that each site for a variable modification is considered with and without the modification. 

o Modifications 

 

Figure 32: Click within the text box to activate the light blue “…” button 

To view the list of modifications included with the default workflow, the user can click within the 
text box to activate the light blue “…” button. It will take a second or two for the window to open.  

The user can then specify any number of modification rules via a pull-down menu containing all the modifications 
listed in www.unimod.org. For convenience, frequently used modifications are listed twice, at the top and again in 
the complete list. The three pull-down menus in each row select modification type, target residues, and fine control. 
There is a fourth pull-down, which lets the user delete, invert (as in (De)Carbamidomethyl), or add “attributes” to 
modifications. Attributes allow the user to define protein-specific modifications. 

 

http://www.unimod.org/
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Figure 33: Select Modifications window 

o Total Common Max and Total Rare Max - A unique feature not found in other search engines is 
offered: the user designates each variable modification as either “common” or “rare”. Separate 
limits on the number of occurrences of each variable modification (rare/common) can be set. 
Please review the Knowledge Base article “Byonic Modification Fine Controls” for details.  

Conceptually, there is one modification “slot” for each residue, along with slots for the peptide’s 
N- and C-termini. A variable modification such as +0.984016 @ N uses up the residue slot; a 
nonspecific terminal modification such as +57.021464 @ NTerm uses up the terminal slot; but 
residue-specific N-terminal modifications, such as -17.026549 @ NTerm Q, use up both the 
residue and the N-terminal slots. 

The big open box is a space for the user to type in custom modifications not listed in Unimod. The 
manual fine control format has the form: 

Modification_Name / Mass_Delta @ Targets | Fine_Control 

Modification_Name / is optional. The Targets field allows the 20 one-letter amino acid 
abbreviations, as well as four special locations: NTerm, CTerm, Protein NTerm, and Protein 
CTerm. NTerm, CTerm, Protein NTerm, and Protein CTerm can also be used as modifiers of 
amino acid residues. Targets form a comma-separated list.  

Here is an example of a real modification not (yet) in Unimod: 

DehydroFormyl / +9.98435 @ NTerm S, NTerm T | rare1 

A limited number of nonstandard amino acid residues is supported by redefining one-letter amino 
acid abbreviations using fixed modifications. B, Z, U, O, J, and X are accepted in FASTA protein 
databases, with masses, respectively, of 114.042927 (same as N), 128.058578 (same as Q), 
150.95363 (selenocysteine), 237.052645 (pyrrolysine), 100.0, and 110.05 (close to averagine). 
By placing, for example, a fixed modification of +13.04768 on J, the user can make J in a FASTA 
database have mass 113.04768, correct for hydroxyproline. However, amino acid sequence is 
used to predict peak intensity, so this fixed modification on J will not give the same scores as a 
+15.9949 variable modification on P. 

For comprehensive sequence variant searches, or other searches with large numbers of 
modifications, it is more convenient to paste in a list of modifications in the custom modification 
box than to add all the modifications via the drop-down menus. Sequence variant lists are 
available from Protein Metrics by contacting support@proteinmetrics.com. 

• Glycans 

 

Figure 34: Glycans are loaded as a list of records 

Three ways to define glycan modifications are offered: internal preset tables, external glycan databases, 
and user-defined glycans. Clicking on the activated light blue “…” button pops up a window labeled 
Select Glycans as shown below. 

mailto:support@proteinmetrics.com
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Figure 35: The Select Glycans window 

Enter glycan databse(s) allows the user to input a database of glycans. Clicking on the drop-down menu 
and selecting Browse takes the user to the C:\Program Files\ProteinMetrics\PMI-

Suite\Base\data\GlycanDatabases folder where the user can select from the databases currently 

included by default with installation. These databases are editable and the user can also add customized 
databases to this folder to select instead. We continually add to this set of glycan databses based on 
customer feedback – please reach out to support@proteinmetrics.com to request additional content. 

 

Figure 36: Glycan databases included with installation 

mailto:support@proteinmetrics.com
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The user can choose Glycan type (N- or O-linked), browse for a text file of glycan compositions, and then 
set the Fine Control (rare1, common2, etc.).  

 

Figure 37: Modification Fine Control options 

The text files include one glycan composition per line; for example, the following gives five of the most 
common human O-glycans. Spaces between monosaccharides are optional, and unused 
monosaccharides can be left out or included with zero (0) occurrences. 

HexNAc(1)  
HexNAc(1) Hex(1)  
HexNAc(1)Hex(1) NeuAc(1) 
HexNAc(1)Hex(1) NeuAc(2) 
HexNAc(1)Hex(1)Fuc(1)  
Enter specific glycan(s) is located in the middle part of Select Glycans and allows the user to input 
glycans one at a time by specifying monosaccharide compositions. 

 

Figure 38: Enter specific glycans 

Here the user chooses Glycan type (N- or O-linked) from the drop-down menu, builds a custom glycan by 
clicking on the white “…” box and entering values in the Edit Glycan window, and then sets the Fine 
Control (rare1, common2, etc.). Six monosaccharide residues are allowed: HexNAc, Hexose, Fucose, 
Pentose (common in plants), NeuAc, and NeuGc (common in non-humans). A box for Sodium is also 
included because this is a common adduct on sialic acids. Other glycan masses and modifications such 
as sulfation and acetylation can be defined with the Additional mass box; this mass is added to the mass 
of the monosaccharides. The total delta mass will automatically populate. The user selects OK to close 
the window and include the value. 

In the third section, the user can add additional glycans using the same format as within the glycan 
database text files.  

For some helpful examples and best practices for conducting N-linked and O-linked glycan searches, see 
our Application Notes at https://www.proteinmetrics.com/resources/. 

• Spectrum Input Options 

These parameters help Byos cope with imperfect inputs. For example, on many MS instruments, 
precursor ion charges are uncertain for some or all spectra.  

https://www.proteinmetrics.com/resources/


 Chromatogram Analysis Manual v5.11                                                                
 

  

  

 

Figure 39: Spectrum Input Options 

o Apply Charges To - By default, the assigned charge will be used for all spectra with assigned 
charges and +1, +2, +3 will be used for all CID spectra and +2, +3, +4 for all ETD spectra without 
assigned charges. The Apply Charges To parameter allows the user to override this default setting 
by instead selecting unassigned spectra.  

o Charge States - All comma-separated charges detailed to each spectrum will be applied (based 
on the values the user entered into the Charge States box).  

o Precursor Isotope Off By X 

 

Figure 40: Precursor Isotope Off By X 

Similarly, on many instruments the nominal precursor mass may actually be the mass of a 13C 
isotope peak rather than of the base (all 12C monoisotopic) peak, so the true precursor mass will 
within 10 ppm of 2350.120 Da or within 10 ppm of 2351.123 Da. Precursor Isotope Off By X is a 
pulldown menu with several options. 

No error check will use only the assigned precursor; Too high (narrow) will allow the assigned 
precursor to be up to 2 Da too high; Too high (wide) will allow the assigned precursor to be up to 
n Da too high for a precursor of mass at least 1000n Da; Too high or low (narrow) will allow the 
assigned precursor to be up to 2 Da too high or 2 Da too low; Too high or low (wide) will allow 
the assigned precursor to be up to n Da too high or 2 Da too low for a precursor of mass at least 
1000n Da. 

o Maximum Precursor Mass - The user can set the Maximum Precursor Mass to be considered. 
o Precursor and Charge Assignments 

  

Figure 41: Precursor and Charge Assignments 

The precursor and charge assignments can also be calculated directly from the MS1 data or use 
the originally assigned values. The user can set this using a drop-down menu. 

o Maximum Number of Precursors per Scan - Multiple precursors per scan is also considered – 
it is recommended for the user to set this to 2 for complex samples and 5-10 if processing MSe 
or DIA data.  
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o Smoothing Width - The user can enter a sigma value in Thomsons for Gaussian smoothing 
and centroiding of Waters or Sciex data. Half-width at peak half maximum (~0.01 m/z) works 
well and is the default value already entered for the user.  

 

• Peptide Output Options 

 

Figure 42: Peptide Output Options 

The Peptide Output Options parameters offer options for filtering the peptide-spectrum matches (PSMs) 
by score. By default, PSM filtering is deferred until after protein ranking, and then filters to control PSM 
FDR on the “true” proteins—those ranked above the top-ranking decoy protein. This method gains 
sensitivity while simultaneously reducing both protein and PSM FDRs. (Two-dimensional target decoy 
strategy for shotgun proteomics, Journal of Proteome Research 10 (12), 5296-5301, 2011.)  

o Automatic Score Cut - To filter PSMs before protein ranking, the user can click Yes to 
activate Automatic score cut and type in a minimum score. When Automatic Score cut is set 
to Yes, the Manual Score Cut value is ignored. Autoscore cut=yes uses multiple fields 
(MS/MS score, MS1 accuracy, and several others) to filter the list of PSMs shown.  

o Manual Score Cut – If Automatic Score Cut is set to No, Manual Score Cut is used. Manual 
Score Cut filters strictly on MSMS score.   

o Show All N-Glycopeptides - The user also has the option to Show All N-Glycopeptides. This 
will show N-Glycopeptide matches regardless of score or FDR. This is recommended for 
simple samples only. This can be especially useful for low energy CID data.  

 

• Protein Output Options 

 

Figure 43: Protein Output Options 

o Protein FDR  

 

Figure 44: Protein FDR options 

This gives the user control of the protein list cut-off. By default, the protein list is cut at 1% protein 
FDR or 20 decoy proteins, whichever comes last, but the user can ask for 2% protein FDR or a 
completely unfiltered (but still ranked) protein list, or No Cuts. 

o Create a Focused Database - If the user clicks this to select Yes, the software is directed to 
output a new FASTA file (labeled focused and appearing in the output objs directory) 
containing only the proteins found in the search, along with suitable decoys (>Reverse) for 
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unbiased FDR estimation. The focused database can then be used for subsequent wide 
searches, including more modifications and/or a wildcard. Of course, the user can also create 
focused databases outside of the software by editing existing FASTA files.  

o Export mzIdentML - The user can also select to export this file as a mzIdentML file.  

 

• Multicore Options 

 

Figure 45: Multicore processing options 

The user can control the number of computer cores of the CPU used through the drop-menu. The Light 
searches uses one core, Normal search uses all available cores minus two, and Heavy search uses all 
available cores. 

• Wildcard 

 

Figure 46: Wildcard parameters. 

 

Figure 47: Wildcard Search drop-down options. 

Wildcard lets the user turn on wildcard searches, set the range for the wildcard mass, and restrict the 
wildcard to certain residues if desired. The options Disabled, Unmodified, and All peptides are available 
through a drop-down menu.  

The Restrict to residues box uses the common 20 single-letter residue abbreviations, and (lower case) 
n denotes peptide N-terminus and (lower case) c denotes peptide C-terminus(e.g. Kn searches lysine and 
N-terminus). Leaving the field blank searches fall residues. A wildcard, even one with a mass range of 
only 50 or 60 Da, greatly increases the size of the search. It is best used with a focused database (see 
the Advanced tab section below) and used either alone or with only a few other modifications enabled. 
Most wildcard mass shifts will be recognizable by an expert; hence, a wildcard can be used to discover 
which known modifications should be enabled in a subsequent search. For more details about the 
wildcard search, see the application note “Byonic™: Wildcard Search™” at 
https://www.proteinmetrics.com/resources/#application-notes. 

By specifying most modifications as rare, it is quite feasible to search for 10 – 20 modification types at 
once with Byonic. Even larger searches are possible with focused protein databases, for example with 
therapeutic proteins. Such a focused database easily allows efficient mutation searches with 200+ 
possible substitutions, or oxidative footprinting searches with 50+ types of oxidations. Glycans and 
wildcards can easily enlarge the search space by 2 to 3 orders of magnitude, so these options should be 

https://www.proteinmetrics.com/resources/#application-notes
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used with care, and in conjunction with only the most common variable modifications (such as oxidized 
methionine or pyro-Glu N-terminus). NOTE: The single most important factor in search time is Total 
common max. Roughly speaking, the search time grows as CT where C is the number of common 
modifications enabled and T is Total common max.  

The Appendix of the Byonic Manual provides examples of frequently found modifications and appropriate 
syntax for including those modifications in a Byonic search. 

Chromatographic Quant  

NOTE: As mentioned in the above MS/MS Ids section, these parameters apply alone to the Reference 
Chromatography (in-silico) and Comparison Chromatography (in-silico) workflows. 

• General 

 

Figure 48: Samples to include in the project 

o Samples - The “*” will apply all parameters to all samples dragged and dropped into the 
Samples tab. 

 

• Candidate Matching 

 

Figure 49: Candidate matching 

These parameters allow the user to set mass assignment, charge range and other candidate matching 
filters before project creation. 

• In-silico options 
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Figure 50: In-silico options 

Parameters are separated into three sections to clarify which pertain to a Theoretical Digest, CSV 
import and both.  

o Enable in-silico digest - The user has the option to click Yes to enable this parameter to 
generate an in-silico list of peptides. The below additional parameters must then be set.  
NOTE: The option to add a list of in-silico peptides from a CSV file is offered through In-Silico 
Peptides CSV.  

o Digestion 

 

Figure 51: Digestion options 

The user can view several options through the drop-down menu. These are detailed as one letter 
residue codes adjacent to cleavage points. The user may enter a customized digestion by typing 
using the following syntax: Name @ Amino acid letters | C-term or N-term. 

o Missed Cleavages Max 

 

Figure 52: Missed Cleavages Max options 

The user can set the maximum number of missed cleavages per peptide by selecting a value 
using the drop-down menu. A value of -1 allows any number of cleavages.  

o Peptide Minimum Mass - The user can set the minimum value of the peptide mass range. 
o Peptide Maximum Mass - The user can set the maximum value of the peptide mass range. 
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o Total Common Max - The user can set the maximum number of common modifications per 
peptide. The search size grows by an order of magnitude with each increase in Total 
Common Max. 

o Total Rare Max - The user can set the maximum number of rare modifications per peptide. 
The search size grows by an order of magnitude with each increase in Total Rare Max. 

o Glycans - The user can specify a glycan database or custom glycans to include in the in-
silico generation. This is done the same as detailed in the MS/MS Ids section. 

o Modifications Options - The user can specify modifications to include in the in-silico 
generation. This is done the same as detailed in the MS/MS Ids section. 

o In-Silico Peptides CSV - This option allows the user to to add a list of in-silico pepitdes from 
an imported CSV file, thus there is no need to run an MS2 search if there are known 
modifications with known masses and retention times. The format for the CSV is shown 
below. 

 

Figure 53: Format for an In-Silico Peptides CSV 

o Skip if in-silico peptide is duplicate of MS2 - The user can click to select Yes. This will skip 
any generated in-silico peptide if one already exists from the MS2 data. It is recommended to 
make this selection when generating in-silico peptides.  

 

• Advanced 

 

Figure 54: Advanced parameters 

o Enable Lock-Mass Calibration - The user can click to select between No and Yes. 
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o Lock Mass (m/z) 

 

Figure 55: Lock mass m/z value options 

The user can enter the calibrant m/z value. Several are also available using the drop-down menu 
or the user can type in a numerical value. If empty, no calibration will be applied.  

o Lock Mass tolerance (ppm) - The user can enter the calibrant m/z mass tolerance value in 
ppm. The user can type in a numerical value or use the up and down arrow keys to increase 
or decrease the value. If empty, no calibration will be applied. 

o Centroid Smoothing Width - The user can enter a sigma value in Thomsons for Gaussian 
smoothing and centroiding of Waters or Sciex data. Half-width at peak half maximum (~0.01 
m/z) works well and is the default value already entered for the user.  

o Elution Prediction Score Min - This filter will find wildtype peptides with scores above this 
value to adjust the elution time.  

o Compute Fragment Coverage - The user can click between Yes and No to compute 
fragmentation coverage at project creation. 

o Advanced Configuration - The user can enter text commands to complete advanced 
processing. These are detailed in the Release Notes included with each quarterly release. 
Please reach out to support@proteinmetrics.com for additional details. 

 

 

• Report 

 

Figure 56: Report Configuration Path 

Each Byos default workflow includes a report template created by our Customer Success team that is 
optimized for the specific type of analysis. If the user prefers a customized report template, they can direct 
Byos to this file using the light blue “…” button. They will be prompted to select an .rptc file. 

• UI Configurations 

 

Figure 57: UI Configurations – UI Column Filters and UI Layout. 

The user can import column filters as well as layout files. This is designed to standardize analyses across 
all users, labs, and sites. The user can direct Byos to the preferred file for each using the light blue “…” 
button. The user will be prompted to select a file, .cft (Filters) or .ini (Layout) file. 

mailto:support@proteinmetrics.com
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• Time Settings 

 

Figure 58: Time Settings 

o Alignment max time sets the maximum alignment value between plots (for example, UV and 
TIC). This value will limit the allowed alignment time between the two signals.  

The default values for both are set to 0.00, which means filtering will not be applied. The user 
can set them to apply the additional processing options. The default value for “Alignment max 
time” is set to 1.00.  

• Label Scripts 

This feature allows users to customize peak labels for Trace plot. 

 

Figure 59: Label Scripts 

Scripts related to trace plot are in C:\Program Files\ProteinMetrics\PMI-

Suite\Base\labelscripts\traceplot folder. To load a script during project creation, select 

Processing nodes, expand Label Scripts, click on … for Trace plot, then click Load to select a script, 
then click OK and Create Project. This will result in creation of the project with custom labels as specified 
in the script.  

The user has an option to load scripts after project creation as well. To customize peak labels after 
project creation, select Rendering options icon, click Edit Annotations, then click Load to select a 
script, then click Open and click OK to display new custom labels.  

• Peak Construction options (older versions of Byos) 

The Peak Construction option parameters formerly found in Byos are now set directly in the Samples tab 
with the buttons Edit trace peak options and Edit global trace peak filters. 
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Main Menu Bar  

The topmost menu bar includes four items: File, Edit, Window, and Help.  

File Menu 

 

Figure 60: File menu 

The File pull-down menus manage project files and export reports and data. The File menus includes items to open 
previously created projects from saved files, to save a copy of an open project, to close a project (yet leave the 
application open), and to exit Byos. Mouse over the Recent Projects menu to open a side window with a list of 
recently visited projects that can be reopened.  

The File menu functions Open Project, Close Project, and Report, respectively, are also available as icon buttons 
below the topmost menu bar. 

 

Figure 61: Menus and toolbar buttons 

File > Export Menu 

File > Export > Report generates a report that includes a summary of the project files, one or more pivot tables 
(that can be visualized as bar charts, etc.), along with plot images. There are other valuable tools for making reports 
and regulatory filing documents. The general report is first opened in Chromatogram Analysis.  

 

Figure 62: File > Export menu 
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Figure 63: Default Chromatogram Analysis report 

The File > Export sub-menu includes the item Generate Multi-document Report. The user can drag and drop in 
Chromatogram Analysis project *.bmap files to create a multi-document report displaying the table and graphical 
data from a series of reports. 

 

Figure 64: Multi-document report 

To learn about reports in detail see the document PMI Reporting Manual.pdf. 
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Edit Menu 

The Edit pull-down menu manages program settings.  

  

Figure 67: Edit menu 

Undo and Redo allow the user to undo or redo changes. These Edit menu functions are also available as the arrow 
toolbar buttons below the menu bar to the right of the Help menu. 

Recompute trace peaks and baseline opens the Trace peak options dialog that includes settings to modify and 
recompute the trace peaks.  
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Figure 68: Trace peak options – post-processing 

This is equivalent to the dialog opened by the Edit trace peak options button in the Sample Input tab when 
creating a new project. Thus, the user has the option to alter the trace processing before and/or after project 
creation. For details, see the Trace Peaks Options section. 

Import peptide candidates opens a dialog to import or manually enter in-silico peptides: 

 

Figure 71: Peptide import and definition 
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Add from CSV file imports glycans from a *.csv file. Add opens the sub-dialog shown above, where the peptide 
sequence, mass and other properties can be added manually.   

Import detached glycan candidates opens a dialog to import or manually enter glycans, similar to the Glycan 
input and Glycan options tabs during project creation: 

 

Figure 72: Glycan import – Glycan input 

Add from CSV file imports glycans from a *.csv file. Add row opens the sub-dialog shown above, where a glycan 
composition can be added manually, along with optional entries for Alias, Start Time and End Time. The Glycan 
options tab defines labels and addicts for the glycans:   
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Figure 73: Glycan import - Glycan options 

Remove candidates removes either unassigned or all in-silico candidates. This can be useful in cases where a 
wrong or incomplete candidate list has been imported. The user may then import a new set of candidates.  

Auto assign candidates will match candidates with observed molecular ions within the m/z and RT tolerances set. 
These tolerances may be changed from their default values as shown in the Advanced and Log tabs section. It is 
possible to manually assign candidates, but this tool is a reliable time-saver, and it is recommended. It is 
recommended to further review auto assigned candidates and edit them as needed.  

Unassign all candidate removes and uncheck all candidate assignments. This function is useful when a newer 
set of candidates needs to be imported. 

Sample table is used to customize the Project view. To add a comment for a sample, click in the Comment cell 
and enter text. To add a new column, click Add custom column, enter the column name and an optional default 
value and click OK twice. The column will appear after Comment in the Project View. To remove a custom column, 
click Remove custom column, select the column, and click OK. 

Protein table is used to add proteins associated with a sample. Proteins are described by name (Accession name), 
sequence, and average mass. They are assigned to samples by the Sample ID. A protein defined in this table will 
automatically be labeled as Reference during automated mass assignments. As above, custom columns can be 
added and removed. 

Show undetected digest peptides in report allows either including or excluding the undetected peptides for 
reporting. Enabling this will result in a new label “ND” in the Peak Comment column in reporting tabs, denoting that 
the specific peptide is not detected in the analyses. 

Attach report configuration attaches a report configuration file to the project, to be used instead of the default 
report configuration. Report configuration files (graphical layouts) are generated from File > Export > Report and 
have the extensions *.rptc or *.lvcfg. This menu can also be used to remove an attached report configuration file. 

Show project creation options is obsolete and can be ignored. 
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Show Byos Project Creation options displays the Byos workflow Project Creation options used to generate the 
project. Users can edit the workflow settings, but these workflow edits are not applied to the current project. There 
is also no option to create projects from this view. Users can use this option to:  

1. View the Project Creation options used to create the current project.  
2. Click Save workflow to save the workflow settings used to create the project as a .wflw file.  
3. Click Save as Portable Workflow to create a to create a folder containing the .wflw and associated files 

(like .rptc). 
4. Edit the Project Creation workflow settings and then click Save workflow to create a new workflow, using 

the current project creation settings as a starting point. The new workflow must be opened using 
File>Launch Workflow to create a new project. 

 

Figure 74: Show Byos project creation options 

The Advanced configuration dialog is used to enter text commands, which are often new features still in beta 
testing. A list of available advanced commands can be found here.  

Adjust colors is used to modify the default colors associated with samples and traces. 

Adjust MS paths is used to modify the path to the source MS file, should the file be moved. Enter or navigate to 
the new directory containing the MS file. 

 

Figure 75: Edit MS file paths 



 Chromatogram Analysis Manual v5.11                                                                
 

  

  

Import document is used to import a Peptide Analysis (ByologicTM) *.blgc project file. 

Window Menu 

 

Figure 76: Window menu 

The Window pull-down menu manages the visual layout, and the arrangement and sizes of the various table and 
plot views. Load Layout opens a saved layout stored to files with extension .ini. Save Layout saves the current 
layout to an .ini file. Restore Default Layout applies the layout used when the application is first opened.  

The current layout can be customized by moving, resizing or editing the view panes. Many of the views (Project, 
Trace plot, Protein coverage, and MS1) can be undocked by double-clicks on the tops of that view to create 
standalone windows that can be moved to another monitor. These views can be click-dragged to new locations in 
the layout. The view can also be resized by hovering over the vertical or horizontal edges between table and plot 

views so that the cursor changes to arrows:  or . Left click and drag the edges up or down or right or left to 
change the sizes of the views. Columns in the table views can be made larger or smaller in same manner. To 
reorder columns in a table, left click the name of the column, and then drag it to the new location. To do a simple 
sort, left click the header once to sort ascending and twice to sort descending. Mouse over a column header to see 
a description of that field. 

Column headers can be modified through the Column Header Editor dialog, opened by a right-click anywhere on 
a table column header. Columns can be rearranged by dragging the header names up or down. To hide a column, 
uncheck the Visible box for that column. This dialog can also be used to specify number of significant figures and 
ranked sorting. The Window > Save Layout menu preserves these edits. The Reset row sorting and Reset 
column order buttons restores the default row and column properties. 

 

Figure 77: Column Header Editor 
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The Search Box can be used to search for specific values or variables, with options to filter for only whole values, 
with case-sensitivity, and to only search in vertical header columns. 

 

Figure 78: Search box filters 

A selected row can be moved to the top or the bottom by clicking Move to Bottom or Move to Top; alternatively, 
the same actions can be performed by pressing Alt + t or Alt + b, respectively.  

 

Help Menu 

 

Figure 79: Help menu 

The Help pull-down menu provides information about the software. The About menu shows the software version 
number, which is needed when reporting issues. The Log menu opens a log containing recent activity; this is helpful 
for troubleshooting problems together with Protein Metrics staff via support@proteinmetrics.com. Support Package 
collects all relevant information helpful for troubleshooting problems together with Protein Metrics staff via 
support@proteinmetrics.com. Open User Guides opens the installed folder with the manuals and quick start guides 
for Protein Metrics software, including PMI Chromatogram Analysis Manual. Online Resources opens the 
www.proteinmetrics.com/secure-resources webpage containing a variety of technical pages and tutorials related to 
PMI software. Register is used to activate the software upon first use.  

Table Menu Bars  

The menu bars at the top of the three table views, Project, Peaks, and Candidates, share icons that manage 
hierarchical lists and filter on data.  

● The  icon expands rows to show “sub-rows”.  

● The  icon collapses rows to hide sub-rows. The use of sub-row depends on the table. For example, in 
the Peaks table, a row is a trace peak and a sub-row is a mass peak within the spectrum.  

● The  icon exports the table to a .csv file for opening with Excel.  

mailto:support@proteinmetrics.com
mailto:support@proteinmetrics.com
https://www.proteinmetrics.com/secure-resources/


 Chromatogram Analysis Manual v5.11                                                                
 

  

  

● The  icon opens a dialog to create custom filters for the data table. (A single column filter can also be 
set by right-clicking on an entry in the column.) 

 

Figure 80: Column filters editor 

Select a column in the first cell, select an operator in the second cell, and enter text in the third cell. A 
second filter row becomes available for further entry. Click the red X after a filter row to delete it. Custom 
filters allow masses to be filtered by mass range, annotation, intensity, and so forth. Custom filters can be 
stored with the project document or exported and imported using the Presets drop-down.  

● The  cell filters the entered text across the content of all columns in the protein and peptide 
tables. The records are filtered automatically as text is entered. Click the  icon to search the string as a 
whole word or as case sensitive. 

● To sort the contents of a column by ascending value, click the column header. Click the column header 
again to sort by descending value. 

Filter Options 

The  icon located on the Peaks, Candidates tables and MS1 plot opens a dialog that allows the user to filter 
peak and candidate data. The three views launch the same filter dialog, opening to the tab applicable to that view. 

From the Peaks table, the magnifying glass icon opens the Filter options dialog: 

  

Trace peak areas generally constitute a critical quality attribute (CQA) for product development and manufacture. 
One of the features of Chromatogram Analysis is the ability to automatically detect significant concentration changes 
between samples in a comparison project for each trace peak.  

The Trace peak filters tab sets the trace range and minimum peak area (percent of TIC, +/-0.10% by default) 
needed to determine which trace peaks will be processed and assigned IDs. It is sometimes desirable to exclude 
ill-behaving areas at the beginning and end of a trace. The Peak comparison options checkbox at the bottom 
flags comparison peaks that are above or below the reference peak by the percentage specified. Flagged 
comparison peaks are colored red in the Trace plot. 
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Figure 81: Filter options – Trace peak filters tab 

The Candidate filters tab sets filters for candidates from the MS2 search results via the Peptide Analysis software 
or Byonic results. When filtering the MS2 results, there is the time uncertainty setting Expand peak search window, 
minimum score, and precursor m/z error setting and validation filters associated with the Peptide Analysis or Byonic 
software. For filtering on MS1 mass accuracy, the MS2 search identifications are already constrained by mass 
accuracy.  

 

Figure 82: Candidate filters tab 
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The Candidate match options to MS1 tab controls the parameters associated with the molecular assignment of 
mass spectral peaks to a trace peak, and consequently the selection of candidates displayed in the Candidates 
table and MS1 plot. There are ranges for charge states allowed for viewing (default is z =1 to 5), ppm tolerance 
(default 10 ppm), and minimum peak intensity percent in the MS1 view (default 10%). This last parameter applies 
to which molecular ions in the MS1 plot are sufficiently intense to be matched to a candidate. In this case, an isotope 
peak is eligible for matching if it is 10% or greater of the intensity of the most intense isotope in the MS1 plot, 
evaluated at the trace time apex of the peptide map peak. Mass spectral peaks below the minimum m/z are ignored. 

 

Figure 83: Candidate match options to MS1 tab 

Table Right-Click Menus 

The Project, Peaks and Candidates tables have context menu items revealed by a right-click on the rows of the 
tables. (Recall that a right-click on the header of these tables opens the Column Header Editor dialog.) 

 

Figure 84: Table right-click menus 

● Export table to CSV saves the table content and headers to a .csv file using parameters chosen in the 
Export data dialog. The user is also given the option to open the saved .csv file in Microsoft Excel.  

● Copy selected row(s) to clipboard copies selected table rows, with their headers to be available for 
pasting into another application.  

● Copy selected cell to clipboard allows the user to copy the contents of the selected cell. It works just 
like CTRL+C. 

● Enable soft select (Project table only) enables selection of rows in the Project table to display them 
individually in the Trace plot and other views, without the need to uncheck the Show checkboxes for the 
other rows. 
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● A set of query options for searching on the clicked text value using any of the available search operators. 
This is an easy way to filter a table based on a specific field value. 

 

Figure 85: Right-click field searches 

A table view’s menus may also include options specialized for that table. 

Project Table and Menu 

The Project table contains information about the sample and data (trace) type. For a reference project, there is 
only one mass spec channel but there can be multiple optical channels:  

 

Figure 86: Project table for reference project 

To display one or all of the traces (channels) present, check the Show trace box at the left. Only one of these traces 
may have peak numbers for annotation (because different traces often have different numbers of peaks above the 
threshold). To choose the trace to annotate, check the Show peaks box. The Trace type shows the data type, and 
the Time offset displays the time difference between the XIC and optical trace times, through a linear time shift often 
needed for flow splitting. The Time offset can be edited by a click on the value, but this is seldom needed.  

Comparison projects display multiple mass spec channels. 
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Figure 87: Project table for comparison project 

Peaks Table and Menu 

The Peaks table is where all important information is displayed in tabular form about the elution peaks and their 
molecular constituents, including analytical details: 

 

Figure 88: Peaks table 

The Peaks table also includes the following specialized buttons:  

● Add Peaks opens a dialog for the input of start and end integration times for new peaks to be added to 
the table. The user can choose between TIC or UV traces if both are active. This function is useful if a 
peak is slightly below the threshold for auto-assignment but the user still wishes to include it.  

● Delete Peaks deletes the selected peak from the table. 

● Merge Peaks merges a contiguous set of selected peaks into a single peak. Use Ctrl-click or Shift-click to 
select a set of peak rows.  

● Split Peak splits a highlighted peak that has a local minimum into two peaks. The time values for the two 
peaks can then be adjusted separately.  

The Peaks table also includes the following specialized right-click menu item:  

● Show protein summary opens a table with protein data for the selected peaks. 
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Figure 89: Protein summary 

Candidates Table and Menu 

The Candidates table contains all the imported candidates relevant to the selected trace peak. When records are 
selected, the corresponding peak labels in the MS1 plot are displayed in red:  

 

Figure 90: Candidates table matched with MS1 plot labels 

As described earlier, candidates can be imported during project creation, and afterwards by using the Edit > Import 
candidates menu. The three sources for imported candidates are Peptide Analysis *.blgc files, Byonic .*.byrslt files, 
and in-silico *.csv files.  

The Candidates table also includes the following specialized buttons:  

● Add Candidate allows for the manual import of a candidate. It opens the New candidate options dialog: 
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Figure 91: New candidate options 

Note that not all the fields require an entry.  

For released glycans, Add Candidate allows for the manual import of a glycan sequence. After selecting a 
peak in the Candidates table, Clicking Add Candidate button will open a pop-up dialog to manually enter 
the glycans. Glycan field is mandatory to edit other fields within this New Candidate options window. 
Editing the Glycan and/or Adduct will update the M (uncharged mass) and M/z (charged mass) fields. 
Click OK to update the Candidates table with the new row.  

Glycans column in the Candidates and Peaks tables will be updated with the new Glycan and Adduct 
information. Sequence column in the Candidates table will be updated with the information provided in 
the Alias field. If Alias field is empty, the Sequence column will be updated using the information 
provided in the Glycan table during the project creation. If there is no matching information in the Glycan 
table, Alias will simply be Glycan::Adduct, for example, HexNAc(2)Hex(1)::Ca[II]. 

 

Figure 92: Manual import of a glycan sequence 

● Delete Candidate removes the selected candidate rows.  

Note the color coding of the rows in the Candidates table as shown in the header: . Blue rows 
represent MS2 search results, pink rows represent in-silico candidates, and green rows represent manual entry. 
When a candidate is assigned, the color takes on a darker shade and a check box appears in the Valid column.  

As described in Edit Menu, there is an auto-assign function for candidates in Chromatogram Analysis. The user 
can manually assign or unassign any candidate by checking/unchecking the Valid box. The criteria for assignment 
(matching) are found in the Filter options dialog box on the Candidate filters and Candidate match options to 
MS1 tabs, as described in Filter Options. For example, for imported MS2 identifications, entering a time in minutes 
for the Expand peak search window by field can be useful.  
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Protein Coverage Table Display and Menus 

The Protein coverage table includes protein and protein coverage data. The accompanying display maps the 
protein sequences of detected peptides to colored lines below each sequence: 

 

Figure 93: Protein Coverage table 

If a highlighted trace peak contains that peptide sequence, it is highlighted in green. Modifications (such as oxidation 
or deamidation) to the peptide are highlighted in neon green. The coverage map is interactive with other views. The 
user may select a row in the protein coverage table to highlight that peptide in the display. The user may highlight 
a trace peak in the Peaks table or trace plot and the corresponding peptide will become highlighted in the Protein 
coverage display.  

The Protein coverage table includes the following specialized menu buttons:  

• The  icon exports the protein coverage data in .csv format. 

• The  icon opens the Protein coverage rendering options dialog: 

 

Figure 94: Protein coverage rendering 

• The  icon turns off and on the Protein coverage table as a split screen with the sequence display. 

Right-click Export table to CSV in the Protein coverage table to save the table content and headers to a .csv file. 
The user is also given the option to open the.csv file in Microsoft Excel. 

Right click in the Protein Coverage sequence display to enable a menu of three specialized options:  
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Figure 95: Protein Coverage right-click menu 

● Rendering options opens the Protein coverage rendering options dialog shown directly above. 

● Export coverage saves the protein sequence graphic as a *.png file. The user is also given the option to 
open it in the default graphic viewer. 

● Export to FASTA saves the protein sequence graphic as a *.fasta file. The FASTA file is then available 
for import into new projects. The user is also given the option to open it in the default FASTA reader. 

Plot Menu Bars  

The menu bars at the top of the two plot views Trace plot and MS1 spectrum share icons that support generic 
operations on plots. These icons appear in almost all of Protein Metrics’s software products.  

• The  icon resets the plot to default zoom level.  

• The  icon enables zooming in. The cursor changes to this icon. Drag across the range of the plot to 
display to zoom to that x-range. By default, the plot’s y-range scales according to the maximum y-value 

within the x-range, but the software also supports freeform zooming as described under the  icon. 

• The  icon enables zooming out. Click anywhere in the plot to zoom out. 

• The  icon enables moving (panning) across the plot. The cursor changes to this icon. Click the plot and 
drag up or down, right or left to view a part of the plot that is off-screen. 

• The  icon performs an undo of the last zoom step.  

• The  icon performs a redo of the last zoom step.  

• The  icon manages plot segments (zoom states).  

 

Figure 96: Plot segments 
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The number displayed in the icon shows how many plot segments are stored (named by the date and 

time of the save). To save the current zoom state as a plot segment, simply click the  icon. To switch 
to a previously stored plot segment, click the drop-down arrow and select the segment name to add, 
remove, rename or edit plot segments, click the drop-down arrow and then click Edit. The zoom state 
names, and x and y minima and maxima may be edited. To display all the plot segments at once, check 
Show segments. Once established, plot segment definitions can be saved and reloaded with the Save 
preset and Load preset buttons. 

The Plot Segment dialog is useful for comparing two or more traces that have large differences in 
appearances (e.g. a very heavily stressed sample versus a reference), sufficiently large that the time 
warping function may yield the wrong results. This tool allows the user to break up the trace into 
segments, manually connecting one or more regions to ensure that the correct areas are aligned by the 
time warping function. For more detail about time warping see the Chromatogram Plot and Menus 
section. 

• The  icon manages how plots are displayed (render options), as well as zoom modes. 

 

Figure 97: Render and zoom options 

o Show candidate match details (MS1 only) displays the settings entered in the Candidate match 
options tab of the Filter options dialog (see the Filter Options section). 

o Show peptide labels (MS1 only) displays peptide labels in red below the identifying labels for the 
corresponding peaks. 

o Show x values and Show y values display the x- or y-coordinates beside plot peaks to the chosen 
number of significant figures. Show delta displays the x or y differences from a reference peak. To 
display the deltas, hover the cursor over the reference peak (which displays as 0). The other peaks show 
the positive or negative differences for that axis. 

o Show centroid peaks (MS1 only) darkens the peaks that are determined to be centroid. 

o Show plot title displays the title of the plot, as generated from field values. The information shown in the 
plot title can be customized by clicking the Edit plot title button. This opens the Template Editor dialog. 
The editor accepts free text or programmatic “short codes” that insert data values into the title. For 
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example, “Time range [[StartTime] - [EndTime]]” displays the starting and ending times derived from the 
trace as part of the title for any of the plots.  

o Show annotations (Trace plot only) displays text values beside peaks, which can be customized with the 
Edit annotations button. This opens the Template Editor dialog. The editor accepts free text or 
programmatic “short code” that use data values in the peak annotations. For example, 
[PeaksDynamicNumber]” displays the ID number for individual peaks in the Peaks table. 

o Label orientation (Trace plot only) sets the angle for the label text, where 0º is vertical. 

o Mass to m/z dot render options (MS1 only). The three checkboxes, Show charge labels, Limit visible 
circles by count, and Limit visible circles by maximum intensity are intended for the Intact Analysis 
software. They are not active for Chromatogram Analysis. 

o Zoom and pan mode options include Free form mode to select the desired y range as well as x range, 
Auto scale mode to select only the x range (the y range is then determined by the value of the highest 
peak), and Locked view mode to keep the current x range (for either m/z and/or m) when moving 
between trace peaks.  

● The Offset entry on the Trace plot and MS1 plot menu bars controls the vertical spacing for stacked 
plots. Offset of 30% means that plots overlap by 70%. Offset of 100% means that plots stack top-to-
bottom without any overlap. An offset greater than 100% leaves white space between the stacked plots.  

Plot Right-Click Menus 

The Trace plot and MS1 plots have a variety of context menus for plot styling and exporting revealed by a right-
click on the plots. Figures exported can be useful for reports, publications, regulatory filings or internal 
communications. There are many options for rendering and exporting so that the user has much freedom to prepare 
a plot or figure style as needed. 

 

Figure 98: Plot right-click menu 

● Show/hide sample name (Trace plot only) toggles the display of sample names beside their 
corresponding peaks.  

● Sample name position (Trace plot only) toggles the display of sample names beside their corresponding 
peaks.  

● Adjust X-Y axis limits opens a dialog for the user to manually edit the plots x and y maxima and minima. 

This is a less convenient but more precise alternative to the  and  icons. 

● Export image allows the user to save the plot as a *.pdf report or as a *.png, *.wmf or *.svg image file. It 
opens the Plot Exporting Settings dialog, which controls image size, file name and folder, and x and y 
minima and maxima. Sometimes a user wishes to display a wide range across the x-axis and yet retain 
significant detail. This can be done by breaking up the plot into a series of panels. The Add segment 
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button creates segments with user-defined x and y values. A series of these segments that eliminates 
unneeded portions of the plot increases the effective detail in the image. This is also a useful function for 
automated reporting.  

 

Figure 99: Plot Exporting Settings 

Note: Image exports also support *.svg image formats. In the file name cell, change the selected 
extension to .svg and click Save. 

● Export image series opens the Plot Export Settings dialog, except that this time it is prepopulated with 
six equal sized segments. This simplifies the edits of the segments. 

● Export all also opens the Plot Exporting Settings dialog, except that the wildtype peptide plots are 
exported along with the peptide plots. Segment editing functions are disabled for this option.  

● Export to CSV exports the plot trace x,y points to a .csv file.  

● Copy to clipboard (all) enables pasting the plot image into another application.  

● Avoid label collision staggers the label text to reduce overlap.  

● Rendering options controls how a plot is displayed in the application. It includes several sub-menus: 

 

Figure 101: Rendering options sub-menu 

o Preconfigured sub-menus control what is displayed in the plots. Default mode displays the trace, peak 
labels and plot title. Show all peak labels does exactly that. Trace only turns off the peak labels and plot 
title. 

o Show x grid lines turns on and off the x grid lines. 

o Show y grid lines turns on and off the y grid lines 
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o Show tracker displays a vertical dotted line that follows the cursor when moved in the plot. This allows a 
more precise determination of the location of the cursor.  

o Y-tick label notation switches between display of Absolute y value, and Percent value as a function of 
the highest peak. 

o Adjust font sizes controls the font size for each type of text on the plot. 

o Plot styles allows changes to the graphic styling of the plot, including trace width, axis width and total 
m/z dot colors to be used.  

 

Figure 102: Adjust plot styles 

o Plot name: The last of the Rendering options sub-menus displays the sample names of each displayed 
trace. Hover over the sample name to see a deeper sub-menu of plot choices. The user can turn on and 
off the trace, graphical integrations and peak labels for that particular sample. The Show/hide all option 
turns all of these options on or off.  

 

Figure 103: Plot name menu options 

● Labels (Trace plot only) opens the Template Editor. The editor accepts free text or programmatic “short 
codes” that insert field data values into the labels. 

Trace Plot and Menus 

The graphical trace of the chromatogram or electropherogram is a key part of the interactive software. It is 
recommended to begin the workflow with a close inspection of the chromatogram, especially the baseline and peak 
integration limits (elution peak definition). If necessary, re-compute using the menu Edit > Recompute trace peaks 
and baseline. After the trace is computed, it is common to make some small manual adjustments to the peak 
integration limits and the baseline. 

To edit the integration time limits for trace peak, first highlight the peak either by clicking on a row in the Peaks table 
or Alt-click the peak in the Trace plot. The integration limits will appear as two magenta vertical lines. Click one line 
at a time and drag it to a different trace time; the Peaks table will automatically update. Alternatively, the user may 
edit the Start time and End time fields in the Peaks table directly.  

The Trace baseline is created with an algorithm that places anchor points on the baseline. These anchor points are 
editable. To manually adjust the baseline, zoom in on the peak of interest and use the baseline anchor options 
described below. 
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If the user turns on the “Snap to Plot” down-arrow button before inserting a new anchor point, then the newly created 
anchor point will snap to the Trace when created   

The Trace plot menu bar includes the following specialized controls:  

● The  icon shows the options for managing baseline anchors. Click this icon to expose three baseline 
anchor options: 

o The  icon moves the ends of a baseline anchor. Move the cursor to either end of the baseline to see 
the anchor displayed in green and the cursor changed to an arrow. Click, and drag the end of the 
baseline to the new location. 

o The  icon inserts a new baseline anchor (polygon vertex). Move the cursor to the baseline to see the 
anchor displayed in green, and the cursor changed to an arrow. Click anywhere within the baseline 
anchor to divide it into two parts at that point. The Move baseline anchor mode can be used to move the 
endpoints of the baseline anchors.  

o The  icon deletes a baseline anchor. Move the cursor to the end of the unwanted baseline to see the 
anchor displayed in green and the cursor changed to an arrow. Click to delete that baseline anchor. 

● The Warp off/Warp on button (for comparison projects only). Warp on applies a dynamic nonlinear time 

warping to bring the trace time profile of each comparison sample into alignment with the reference file 

(bottom trace in the pane). The following two images show comparison traces with Warp off and then 

Warp on:  

   

Figure 104: Comparing effects of Warp off and Warp on 

The warping tool is essentially an inspection tool to help the analyst judge if all the right peaks are being 
compared to the each other. The actual quantification for all peak areas is calculated in unwarped 
(original) time. The time warp algorithm is robust in terms of recognizing which trace peaks in different 
samples correspond to each other, but if the comparison involves traces that begin to dramatically differ 
in appearance, as can be the case for example with highly stressed samples, then the time warp 
algorithm may sometimes make mistaken connections between the trace peaks in some regions. In such 
cases, the user may use the segment tool in the Trace plot view to lock together a particular region(s) that 
they know are the same molecule and thus constrain the nonlinear The Center button pans the trace to 
put a selected peak in the center. 

● The Label button opens the Template Editor for peak labels. This functions the same way as the 
Annotations function in the Rendering and zoom options dialog. The editor accepts free text or 
programmatic “short codes” that can use field data as peak labels. 

● The slider to the right of the Label button changes the allowable distance of labels from reference points. 
Moving the slider to the right will display more labels that are further apart. Dotted lines connect the extra 
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labels to their peaks. Moving the slider to the left will reduce the number and separation of the labels. For 
example, with slider to the left, there can be label collision: 

 

Figure 105: Minimum label separation can hide or overlap labels 

As the slider is moved to the right, more labels are shown, and they are spaced further apart: 

 

Figure 106: Increasing label separation shows more and clearer labels 

MS1 Plot and Menus 

For the graphical display of MS1 data, the toolbar at the top has much in common with that described earlier for the 
Trace plot view.  
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Figure 107: MS1 Plot 

The MS1 plot menu bar includes the following specialized controls:  

● The  icon turns on and off the time-correlation color function. This function calculates the mathematical 
correlation coefficient of the MS1 intensity over the time-intensity profile of the trace peak as a function of 
m/z. Well correlated peaks (1.0-0.8) are colored green. Less correlated peaks are colored magenta. 
Poorly correlated peaks (0.4-0.0) are colored grey. Click the icon to turn the correlation colors on or off. 
The dropdown arrow includes Time profile similarity options (which generally needs no adjustment and 
Show/hide color map. Click the latter to turn on and off the color bar scale on the right-hand side of the 
MS1 view. 

In the above figure, assigned candidates are shown in a bold font. The ID number displayed in red refers 
to the candidate shown in the Candidates table. Hover the mouse over a mass peak to display the mass 
differences of the other peaks relative to the inspected peak. This is useful to quickly check charge states 
or check masses associated with modifications like oxidation or sodiation. 

● The  icon shows the same dialog with the same options described in the Filter Options section. In the 
case of the MS1 plot, the filter options apply to displayed peaks, as well as to the rows of the Peaks and 
Candidates tables. 

Appendix 

Chromatogram Analysis: Advanced Commands 

Chromatogram Analysis includes many ways to customize the functionality to fit specific needs. Protein Metrics 
uses Advanced Commands to test new ideas, beta-test new features, and enable specialized options, without 
adding complexity to the graphical user interface. This section describes several text-format Advanced Commands 
that will enable finer control over processing. Advanced commands may be entered during project creation in the 
Advanced configuration panel of the Advanced tab or after project creation by choosing Edit -> Advanced 
configuration. 

1. Assume Proline Cuts allows the counting of cleavages to include cuts at proline. 

[Byomap] 
AssumeProlineCuts=1 
 
2. Remove Duplicates ensures that candidates will only be assigned to the most abundant trace peak during 

auto-assignment. This is enabled (set to 1) by default. If disabled (set to 0), candidates may be assigned to 
more than one trace peak. 

[AutoAssign] 
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RemoveDuplicates=0 
 
3. Remove Duplicates ISD If enabled (set to 1), excludes in-source dissociation candidates from auto-

assignment. A glycan is treated as a subcomposition of another candidate glycan for the same peak. This is 
disabled (set to 0) by default. If disabled (set to 0), in-source dissociation candidates will be treated no 
differently from other candidates during auto-assignment. A glycan is either the same composition or a 
supercomposition of the other candidate glycans for the same peak..If set to <blank>, the candidate does not 
represent a glycan. 

[AutoAssign] 
RemoveISD=1 
 
Please note: 

o Candidates with RemoveISD enabled (set to 1) will not be auto-assigned by Edit > Auto assign 
candidates 

o Auto-assignment will only refrain from assigning ISD candidates; it will not unassign candidates that are 
already assigned. If auto-assignment has already been run for the project in a build without this feature, 
the user should first choose Edit > Remove all candidate assignments to unassign possible ISD 
candidates. 

4. Insert Anchors injects manual baseline points when the baseline smoothing parameter alone is inadequate. 
This will help to keep big dips out of the calculated area if points just outside the time range are included, as 
depicted below: 

[Baseline] 
InsertAnchors=19.27,20.12 
 

 

Figure 108: Insert baseline anchors 

Note that this function requires the user to have knowledge of where to place the baseline points. The values 
19.27 and 20.12 were observed from the trace. 

5. EnableMS1Sum performs MS1 scan summing with corresponding noise reduction. This makes it easier to 
find and assign low level glycans (and peptides) in noisy MS1 spectra: 

[Byomap] 
EnableMS1Sum = true 
TimeCorrFilterValue = 0.1 
 
With scan summing, the displayed MS1 will be the sum of all scans between the two pink bars that mark the peak 
boundaries. When disabled, the displayed MS1 scan will be a single scan taken at the point indicated by the blue 
bar (usually the peak apex). 

TimeCorrFilterValue controls MS1 background noise reduction. The time correlations correspond to the color 

coding used in the MS1: well correlated peaks (coefficients > 0.8) are colored green, less well correlated peaks 
(coefficients between 0.4 and 0.8) are colored magenta and poorly correlated peaks (coefficients below 0.4) are 
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colored grey. The threshold setting removes any of these poorly correlated ions from the MS1 results that fall below 
that setting.  

It is recommended to first try with TimeCorrFilterValue = 0.1 to reduce noise levels without over filtering the 

data. Increasing this value to 0.4 removes most of the gray, poorly correlated peaks. Further increasing this value 
to 0.6, removes the pink non-correlating peaks. An example of a plot before and after scan summing noise reduction 
is shown below: 

 

Figure 109: Scan summing for noise reduction 

This advanced command also results in scan time range label for the MS1 plot title. 

6. AddDuplicates control how homologous peptide sequences are annotated in the Protein coverage table. 
Two options allow Protein coverage to be digestion-aware: 

[ProteinCoverage] 
AddDuplicates = 1 
 
The options for AddDuplicates are: 

o 1 - duplication within the same protein 

o 2 - duplication across all proteins 

o 3 - duplication within the same protein applying protease specificity 

o 4 - duplication across all proteins applying protease specificity 

Note: if the advanced command is not used, the default is option 4. The protease is specified in the Digestion 
dropdown in the In-silico tab during project creation. If no protease is specified (i.e, Digestion is blank), the 

project will be created with AddDuplicates = 2. 

7. HideLabelsIfCollision controls whether labels are hidden in the case of label collisions (the default setting is 
true): 

[Plot] 
HideLabelsIfCollision = true 
 
8. EnableGlycanCartoons displays the peak labels as glycan cartoons. The size of the glycan cartoons can be 

controlled with GlycanCartoonsSymbolSize parameter. The default size is 4. 



 Chromatogram Analysis Manual v5.11                                                                
 

  

  

 

Figure 110: Glycan Cartoons 

[Plot] 
EnableGlycanCartoons=true 
GlycanCartoonsSymbolSize=12 
 
The above advanced commands will result in glycan cartoons with size set to 12. 

The user has the option to choose from alternative representations of selected glycan structures by right clicking 
on a candidate that has a glycan composition, which will provide the option to Show alternative glycan structures.  

 

Figure 111:Show alternative glycan structures 

This will open a Glycan Structure Selection window from which the user can choose between a menu of structures 
that are maintained in a backend library and match the glycan composition. The example below shows that in 
addition to the G0 structure for HexNAc(4)Hex(3), there are two other bisecting GlcNAc options that the user can 
display.  
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Figure 112:Glycan Structure Selection 

If the user selects one of these alternatives and clicks ‘OK', the structure shown in the chromatogram and reports 
will update to the user selection. 

 

Figure 113: Updated glycan cartoon 

Structures included in the table are maintained in a backend library, but a user can add additional structures by 
clicking Add new from IUPAC. This button will open a new window where the user can provide a text representation 
of the glycan structure in condensed IUPAC format.  
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Figure 114: Add new from IUPAC... 

For example, if an O-linked type glycan is preferred, the user can input: 

 

Figure 115: O-linked type glycan input 
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Varying degrees of specificity are available within this feature. For example, if the user wishes to display complete 
specificity, they can annotate edges with anomeric and linkage information. Or, alternatively, if more less specificity 
is needed, brackets denoting ambiguous connectivity can be rendered. 

 

Figure 116: Additional structures  

If the user has provided a proper IUPAC text that matches the corresponding composition, a structure preview will 
be displayed after clicking ‘Draw’. Clicking ‘Add’ will add the new structure to the backend library and it will become 
available in the ‘Glycan Structure Selection’ menu. 

 

Figure 117: Adding IUPAC structure to library 
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If the user has provided an invalid IUPAC text or one that does not match the composition, a warning message will 
be displayed.  

 

Figure 118: Invalid IUPAC 

Online resources, such as GlyConnect’s Structure List, are available for the user to find condensed IUPAC text for 
various structures. 

 

Figure 119: GlyConnect's Structure List site 

However, if the user wishes to construct their own IUPAC text, the following instructions are available.  

The condensed IUPAC format encodes the glycan’s tree structure in a linear, text format, where the branching 
events are denoted by square brackets, []. The example below shows two GlcNAc()Man() branches are extended 

https://glyconnect.expasy.org/browser/structures
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off of the core Man()GlcNac()GlcNAc(). This structure is represented by the IUPAC 
GlcNAc()Man()[GlcNAc()Man()]Man()GlcNAc()GlcNAc().  

 

Figure 120: Preview for GlcNAc()Man()[GlcNAc()Man()]Man()GlcNAc()GlcNAc() 

In the case of a bisecting GlcNAc structure, where three branches are extended off the core mannose, an additional 
set of brackets can be used:  
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Figure 121: Bisecting GlcNAc structure 

Anomeric and linkage annotation is provided in the parenthesis after each monomer in the format Xn-m, where X 
can be either ‘a' (alpha) or 'b’ (beta), n is always 1 and so is not rendered, and m is the carbon from which the 
monomer is extended. 

 

Figure 122: Annotation and linkage information included 

For ambiguous connectivity displayed with brackets, the floating extensions are denoted in quotes after a '+' from 
the main tree structure (i.e., [coreStructure]+”[bracketStructure1], [bracketStructure2], etc.” ) 

  

Figure 123: Additional types of connectivity 
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An option to include the intact cartoon within annotated glycan MS2 spectra is available as of Byos v5.6. It can be 
found under the same control as the peptide fragment map. 

 

 

A list of supported monosaccharides that can be used in condensed IUPAC interpretation is shown below: 

Name Composition IUPAC Shape Color 

Allose Hex All() Circle Purple 

Altrose Hex Alt() Circle Pink 

Arabinose Pent Ara() Star Green 

Deaminated neuraminic acid Kdn Kdn() Diamond Green 

Deoxyaltrose dHex 6dAlt() Triangle Pink 

Deoxygulose dHex 6dGul() Triangle Orange 

Deoxytalose dHex 6dTal() Triangle Light blue 

Fucose dHex/Fuc Fuc() Triangle Red 

Galactose Hex Gal() Circle Yellow 

Generic deoxyhexose dHex dHex() Triangle Unfilled 

Generic hexose Hex Hex() Circle Unfilled 

Generic N-acetylhexosamine HexNAc HexNAc() Square Unfilled 

Generic pentose Pent Pent() Star Unfilled 

Generic sialic acid NeuAc Sia() Diamond Red 

Glucose Hex Glc() Circle Blue 

Gulose Hex Gul() Circle Orange 

Idose Hex Ido() Circle Brown 

Lyxose Pent Lyx() Star Yellow 

Mannose Hex Man() Circle Green 

N-acetylallosamine HexNAc AllNAc() Square Purple 

N-acetylaltrosamine HexNAc AltNAc() Square Pink 
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N-acetylgalactosamine HexNAc GalNAc() Square Yellow 

N-acetylglucosamine HexNAc GlcNAc() Square Blue 

N-acetylgulosamine HexNAc GulNAc() Square Orange 

N-acetylidosamine HexNAc IdoNAc() Square Brown 

N-acetylmannosamine HexNAc ManNAc() Square Green 

N-acetylneuraminic acid NeuAc NeuAc() Diamond Purple 

N-acetyltalosamine HexNAc TalNAc() Square Light blue 

N-glycolylneuraminic acid NeuGc NeuGc() Diamond Light blue 

Neuraminic acid Neu Neu() Diamond Brown 

Quinovose dHex Qui() Triangle Blue 

Rhamnose dHex Rha() Triangle Green 

Ribose Pent Rib() Star Pink 

Talose Hex Tal() Circle Light blue 

Xylose Pent Xyl() Star Orange 

Table 1: Supported monosaccharides for condensed IUPAC 

 

Note: This feature was designed for one glycan/composition/IUPAC per row, so it does not allow editing for multiply 
glycosylated peptides.  

 

Glycan Name Composition 

AGly Null 

GlcNAc HexNAc(1)  

GlcNAc2 HexNAc(2)  

GlcNAc F HexNAc(1)Fuc(1)  

GlcNAc2 F HexNAc(2)Fuc(1)  

Man1 HexNAc(2)Hex(1)  

Man2 HexNAc(2)Hex(2)  

Man2F HexNAc(2)Hex(2)Fuc(1)  

Man3 HexNAc(2)Hex(3)  

Man3F HexNAc(2)Hex(3)Fuc(1)  

Man4 HexNAc(2)Hex(4)  

Man5 HexNAc(2)Hex(5)  

Man5F HexNAc(2)Hex(5)Fuc(1)  

Man6 HexNAc(2)Hex(6)  

Man7 HexNAc(2)Hex(7)  

Man8 HexNAc(2)Hex(8)  

Man9 HexNAc(2)Hex(9)  

Man3 +GlcNAc HexNAc(3)Hex(3)  

G0F - arm HexNAc(3)Hex(2)Fuc(1)  

G0 -GlcNAc HexNAc(3)Hex(3)  

G0 - arm HexNAc(3)Hex(2)  

G0F -GlcNAc HexNAc(3)Hex(3)Fuc(1)  

G1 -GlcNAc HexNAc(3)Hex(4)  

G1F -GlcNAc HexNAc(3)Hex(4)Fuc(1)  

G0 HexNAc(4)Hex(3)  

G0F HexNAc(4)Hex(3)Fuc(1)  
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G1 HexNAc(4)Hex(4)  

G1F HexNAc(4)Hex(4)Fuc(1)  

G2 HexNAc(4)Hex(5)  

G2F HexNAc(4)Hex(5)Fuc(1)  

G1F SA HexNAc(4)Hex(4)Fuc(1)NeuAc(1)  

G2 SA HexNAc(4)Hex(5)NeuAc(1)  

G2F SA HexNAc(4)Hex(5)Fuc(1)NeuAc(1)  

G2 SA2 HexNAc(4)Hex(5)NeuAc(2)  

G2F SA2 HexNAc(4)Hex(5)Fuc(1)NeuAc(2)  

G2 SA1 NA1 HexNAc(4)Hex(5)NeuAc(1)NeuGc(1)  

G2F SA1 NA1 HexNAc(4)Hex(5)Fuc(1)NeuAc(1)NeuGc(1)  

G2  NA HexNAc(4)Hex(5)NeuGc(1)  

G2  NA2 HexNAc(4)Hex(5)NeuGc(2)  

G2F NA2 HexNAc(4)Hex(5)Fuc(1)NeuGc(2)  

G2F NA HexNAc(4)Hex(5)Fuc(1)NeuGc(1)  

Table 2: List of Common Glycans and their Compositions 

Also added in v5.6 is the ability to include relevant modifications into the glycan structure. These include 
phosphorylation, sulfation, acetylation, N-acetylation, and the additions of phosphocholine and pyruvate . They 
are denoted in IUPAC string as Phos(), Sulfo(), Ac(), NAc(), Pyr(), and PC() and represented by red, brown, blue 
(Ac and Nac), orange, and pink circles, respectively, with mod acronyms written in white lettering. 

Phospho:  

 

Acetylation:  
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N-Acetylation:  

 

Sulfation:  

 

Phosphocholine: 



 Chromatogram Analysis Manual v5.11                                                                
 

  

  

 

Pyruvate:  

 

9. Released Glycan workflows currently match glycan compositions to elution peaks by accurate mass matching 
at the MS1 level. Tandem MS of released glycans can provide further confidence to peak annotations, as well 
as evidence of a glycan’s higher order structure. We now provide the option to annotate and score tandem 
MS spectra to aid in their characterization. This functionality is enabled with the advanced commands listed 
below:  

[Byomap] 
EnableMS2=true 
Ms2Tolerance=0.2 da 
 
[Plot] 
EnableGlycanCartoons=true 
GlycanCartoonsSymbolSize=4 

 

The value of the Ms2Tolerance should be in line with the mass accuracy of the mass analyzer used.  

If the input data contains tandem MS spectra, the user will be provided a list of scans matching the candidate’s 
intact mass within the time limits of the peak in the ‘MS2 Data’ table. Selection of a row in this table will then display 
the spectrum in the ‘MS2 Plot’ window, annotated with glycan fragments in SNFG format. 
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The B, C, Y, and Z-type candidate fragments ions originating from up to 3 cleavage events, as well as associated 
acetyl losses, are generated from the IUPAC glycan structure associated with candidate. This allows the user 
to view the differential coverage of the tandem MS with different glycan structures by choosing between 
different structure options. A probability score based on a cumulative distribution function is provided to help 
in the assignment. Below is an example where the MS spectra contains more evidence for G2F (score = 
43.48) than a bisecting GlcNAc structure with the same composition (score = 35.07). 
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10. Charge and monoisotope checks have been added to glycan fragment annotation. The 
implementation requires profile scan data; therefore, if a user has centroid data, this check should be 
turned off with the following advanced command:  

[MS2] 
ChargeDetermination=false 
 


